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QUESTION 1: 
 
Describe the procedures for assigning the Personal category to an e-mail message. Assume 
you are currently viewing the contents of the Inbox folder. Select all that apply. 
 
A. Right click the message, and select Categories from the shortcut menu. Click the Personal 
check box, and click Ok. 
B. Open the message by double clicking it. Select Edit, Categories on the menu bar. Click the 
Personal check box, and click Ok. 
C. Select the message. Select Edit, Categories on the menu bar. Click the Personal check box, 
and click Ok. 
D. Select the message. Select File, Categories on the menu bar. Click the Personal check box, 
and click Ok 
 
Answer: A, C 
 
Explanation: The Tools menu does not contain the Categories command. When a message 
is open, the Categories command is not on the Edit menu. Answers A and C are the most 
common methods of assigning a category to a message. 

 
QUESTION 2: 
 
Select all methods that can be used to open a message. Select all that apply. 
 
A. Left click the message and select Open from the shortcut menu 
B. Select the message, and perform a Ctrl-O on the keyboard. 
C. Right click the message and select Open from the shortcut menu. 
D. Select the message and press Enter on the keyboard. 
 
Answer: B, C, D 
 
Explanation: Answers B, C, and D are less familiar methods of opening a message. The 
most common method is to double click the message. Answer A is incorrect, as left clicking 
does not call up a shortcut menu. 

 
QUESTION 3: 
 
Donald is reading a new message without opening it. How can he do this? 
 
A. The message is selected and he is reading it in the view pane. 
B. The message is selected and he is reading it in the inbox pane. 
C. The message is selected and he is reading it in the preview pane. 
D. The message is selected and he is reading it in the window pane. 
 
Answer: C 
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Explanation: If the Preview Pane is turned on, selected messages in the message pane can 
be read in the preview pane. The preview pane is turned on by selecting View, Preview 
Pane on the menu bar or by clicking the Preview Pane button on the Advanced toolbar. 

 
QUESTION 4: 
 
You have created a new mail message that you will send to a co-worker and you want to 
build and send an Excel worksheet along with the message. How can you accomplish this 
task without separately launching Excel? 
 
A. Select File, New, Office Document on the menu bar. When the New Office Document dialog 
box displays, double click the Excel program icon 
B. Select Tools, Office Document on the menu bar. When the New Office Document dialog box 
displays, double click the Excel program icon 
C. Select New, Excel Workbook on the menu bar. When the New Excel Workbook dialog box 
displays, double click the Excel worksheet icon. 
D. Select File, New, Excel document on the menu bar. When the New Excel Document dialog 
box displays, double click the Excel worksheet icon. 
 
Answer: A 
 
Explanation: After executing the commands in Answer A, a dialog box displays asking you 
if you want to Post the document in this folder or Send the document to someone. When 
you select Send the document to someone, a new message window appears with a second 
Document window behind it containing the specified MS Office file such as Excel, Word, or 
PowerPoint. 

 
QUESTION 5: 
 
When a task has been marked as completed by placing a check mark in the task, how does 
the task Subject and Due Date appear in the Tasks folder? 
 
A. A single line goes through the task 
B. A double line goes through the task 
C. That task disappears 
D. The task becomes bold 
 
Answer: A 
 
Explanation: When a task is marked as completed, a single line goes through the task and 
the % of Completion is changed to 100%. A task is created by selecting the Tasks folder 
from the folder list and selecting the New Task button on the toolbar. Tasks are usually 
assigned to other people who can either Accept or Reject 
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QUESTION 6: 
 
Pick the most efficient way to add a contact to a category. 
 
A. Select the contact from the Contacts folder, select View, Categories on the menu bar, select 
the desired category and click Ok. 
B. Select the contact from the Contacts folder, select Tools, Categories on the menu bar, select 
the desired category and click Ok. 
C. Select the contact from the Contacts folder, select File, Categories on the menu bar, select the 
desired category and click Ok. 
D. Right click the contact from the Contacts folder, select Categories from the shortcut menu, 
check the desired category, and click Ok. 
 
Answer: D 
 
Explanation: Answers A, B, and C have erroneous menu commands. The Edit menu is used 
to display the Categories dialog box. In this case, D is the most efficient way to add a 
contact to a category. 

 
QUESTION 7: 
 
Select all of the methods that can be used to create a new appointment. Select all that 
apply. 
 
A. Select the Inbox folder from the folder list. Select the dropdown arrow on the New Message 
toolbar button and select New Appointment on the dropdown list. 
B. Select the Calendar folder from the folder list, and click the New Appointment button on the 
toolbar. Click the 1-Day button on the toolbar and double click a time block. 
C. Select Inbox from the folder list. Click the 1-Day button on the calendar toolbar. Double click 
a time block in the calendar. 
D. Perform a Ctrl-Shift-A on the menu bar. 
 
Answer: A, B, D 
 
Explanation: Although Answer A is a little inefficient, it would still work. Answer C would 
not work as the appointment toolbar does not display when the Inbox folder is selected. 
Answers B and D are the two most common ways to create a new appointment. 

 
QUESTION 8: 
 
You currently have a message open. What is the correct menu bar sequence to save the 
message as a text only file to the disk in drive A:? 
 
A. Select File, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in drop 
down list at the top of the Save As dialog box. Select Text Only (*.txt. from the Save as type 
dropdown list. Click the Save button. 
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B. Select Tools, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in 
drop down list at the top of the Save As dialog box. Select Text Only (*.txt. from the Save as 
type dropdown list. Click the Save button. 
C. Select File, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in drop 
down list at the top of the Save As dialog box. Select Rich Text Format (*.rtf. from the Save as 
type dropdown list. Click the Save button. 
D. Select File, Save As Text File on the menu bar. Select Text Only (*.txt. from the Save as type 
dropdown list. Click the Save button. 
 
Answer: A 
 
Explanation: Answer B is incorrect as the Save As command is not on the Tools menu. 
Answer C saves the file as a Rich Text Format file. Answer D is incorrect because there is 
no Save As Text File command on the menu bar. By default, the default folder would be 
My Documents which is on drive C. 

 
QUESTION 9: 
 
Select all methods that can be used to create a contact. Select all that apply. 
 
A. Select the Contacts folder in the folder list. Click the New Contact button on the toolbar. Key 
in the contact information, and click the Save and Close button on the toolbar. 
B. Select Tools, New Contact on the menu bar. Key in the contact information, and click the 
Save and Close button on the toolbar. 
C. Select the Contacts folder in the folder list. Perform Ctrl-N on the keyboard. Key in the 
contact information, and click the Save and Close button on the toolbar. 
D. Select the Contacts folder in the folder list. Right click anywhere in the contacts window, and 
select New Contact on the shortcut menu. Key in the contact information, and click the Save and 
Close button on the toolbar. 
 
Answer: A, C, D 
 
Explanation: All are valid methods of creating a contact except answer B. The Tools menu 
does not have any contact options. 

 
QUESTION 10: 
 
By what three attributes can notes be changed? Select all that apply. 
 
A. Size 
B. Color 
C. Font 
D. Icon 
 
Answer: A, B, C 
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Explanation: Note sizes are small, medium, and large. Note colors include, white, blue, 
pink, green, and yellow. To change Note color, right click the note, and select Color from 
the shortcut menu. To modify other note settings, select Tools, Options on the menu bar. 
Select the Note Options button from the Preferences tab on the Options dialog box. Set the 
options from the Note Options dialog box, and click Ok. 

 
QUESTION 11: 
 
Select all TRUE statements in reference to attaching files to messages. Select all that apply. 
 
A. Only one message can be attached to a message. 
B. A file can be attached to a new message by selecting the paper clip button on the toolbar. 
C. Multiple files can be attached to a message. 
D. Select File, Insert File on the menu bar to attach a file to a message. 
 
Answer: B, C 
 
Explanation: Any type of file(s. can be attached to an e-mail message. When a file is 
attached to a message, an icon within the message represents the file. When a recipient 
receives an e-mail message with a file attachment, there is a paperclip icon next to the 
message when viewed in the Inbox. 

 
QUESTION 12: 
 
Which choice below is NOT an option when delivering a message? 
 
A. Delivery Receipt 
B. Sensitivity 
C. Open Receipt 
D. Read Receipt 
E. Voting buttons 
 
Answer: C 
 
Explanation: Open Receipt is not a message option. Other message options include 
Importance Levels and Have replies sent to. To set message options, create a new message 
and click the Options button on the toolbar. 

 
QUESTION 13: 
 
When invitations are sent out for a meeting, they can be any of three roles. Which role is 
not available to a meeting attendee? 
 
A. Resources 
B. Required 
C. Mandatory 
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D. Optional 
 
Answer: C 
 
Explanation: People who must attend the meeting are set as Required. People who can 
come to the meeting if they wish, are Optional. Conference rooms and equipment such as 
video projectors and televisions are Resources. Mandatory is not a meeting attendee role. 

 
QUESTION 14: 
 
Jack has just created a folder called Important Mail. How can he move messages from the 
Inbox into the newly created folder? Select all that apply. 
 
A. Select the messages in the Inbox. Drag and drop them into the Important Mail folder. 
B. Select the messages in the Inbox. Right click the selected messages, and select Move to 
Folder on the shortcut menu. Select the Important Mail folder from the dialog box, and click Ok. 
C. Select the messages in the Inbox. Right click the selected messages, and select Locate to 
Folder on the shortcut menu. Select the Important Mail folder from the dialog box, and click Ok 
D. Select the messages in the Inbox. Right click the selected messages, and select Copy to Folder 
on the shortcut menu. Select the Important Mail folder from the dialog box, and click Ok 
 
Answer: A, B 
 
Explanation: Answer C is incorrect because Locate to Folder is not a shortcut menu option. 
Answer D is incorrect because the shortcut menu option is Move to Folder not Copy to 
Folder. Answers A and B are the most common methods of moving messages between 
folders. 

 
QUESTION 15: 
 
Select the proper procedures for assigning the Favorites category to a single note? Select all 
that apply. 
 
A. Select the note. SelectEdit, Categories on the menu bar. Check the Favorites category check 
box, and click Ok. 
B. Select the note. Select File, Categories on the menu bar. Check the Favorites category check 
box, and click Ok 
C. Right click the note and select Categories on the shortcut menu. Check the Favorites category 
check box, and click Ok 
D. Select the note. Select View, Categories on the menu bar. Check the Favorites category check 
box, and click Ok 
 
Answer: A, C 
 
Explanation: Categories can be assigned to notes by either using answers A or C. Answers 
B and D contain incorrect menu bar commands. 
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QUESTION 16: 
 
Gayle is creating a new mail message. What levels are available when she selects the 
Sensitivity dropdown list located in the Message Options dialog box? Select all that apply. 
 
A. Private 
B. Classified 
C. Restricted 
D. Confidential 
E. Secret 
 
Answer: A, D 
 
Explanation: There are four sensitivity levels that can be applied to a message: Private, 
Personal, Confidential, and Normal. Normal is the default level assuming the default 
settings have not been changed. Classified, Secret and Restricted do not exist. To set 
sensitivity levels from a new mail message window, select the Options button on the 
toolbar. 

 
QUESTION 17: 
 
Pick the TRUE statements in reference to printing an open message. Select all that apply. 
 
A. The print button is located on the Standard toolbar. 
B. Activate the Print dialog box by performing a Ctrl-P on the keyboard. 
C. Select Tools, Print on the menu bar. 
D. Select File, Print on the menu bar. 
 
Answer: A, B, D 
 
Explanation: Answers A, B, and D are the most common methods of printing an open 
e-mail message. There is not a print option on the Tools menu. 

 
QUESTION 18: 
 
Besides the File menu, what other menu bar item can be used to create a new mail 
message? 
 
A. Tools 
B. View 
C. New 
D. Actions 
 
Answer: D 
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Explanation: Selecting Actions, New Mail Message on the menu bar is a less common 
method of creating a new mail message. The most common method is to either click the 
New Message button on the toolbar or by double clicking a blank area of the message pane. 

 
QUESTION 19: 
 
Kyle wants to create a meeting that takes place every third Thursday of the month. How 
can Kyle accomplish this task? Select all that apply. 
 
A. Select the Calendar folder from the folder list. Select Tools, New Meeting Request on the 
menu bar. Select the Recurrence button on the toolbar. 
B. Select the Inbox folder from the folder list. Select Actions, New Meeting Request on the 
menu bar. Select the Recurrence button on the toolbar 
C. Select the Calendar folder from the folder list. Select File, New, Meeting Request on the 
menu bar. Select the Recurrence button on the toolbar 
D. Select the Calendar folder from the folder list. Select Actions, New Meeting Request on the 
menu bar. Select the Recurrence button on the toolbar 
 
Answer: C, D 
 
Explanation: To create a recurring meeting, select the Calendar folder in the folder list. 
Select Actions, New Meeting Request on the menu bar. Select the Recurrence button on the 
toolbar. 

 
QUESTION 20: 
 
When a folder has been archived, what default filename extension is assigned to the 
archived file? 
 
A. PTS 
B. STP 
C. PST 
D. SPT 
 
Answer: C 
 
Explanation: When a folder is archived, the file which contains the archived information 
has a pst extension by default. An example of an archived filename is oldmail.pst. To 
archive a folder, select the folder in the folder list, click File, Archive on the menu bar, key 
the filename, and click Ok. 

 
QUESTION 21: 
 
Sean has opened a message and he wants to send a reply. He also wants the reply to be sent 
to everyone that was carbon copied on the original message. What button can he select on 
the toolbar so everyone will receive his reply? 
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A. Reply to Everyone 
B. Reply to All 
C. Reply 
D. Send to all 
 
Answer: B 
 
Explanation: Selecting the Reply to All button will send the reply to everyone that was 
carbon copied the message. Answers A and D do not exist. Answer C would send the reply 
to the original sender only. 

 
QUESTION 22: 
 
You have created a meeting and you need to reserve Conference Room A for the meeting. 
What role will the conference room play in the meeting? 
 
A. Required 
B. Resources 
C. Support 
D. Optional 
 
Answer: B 
 
Explanation: Resources are non-human support for meetings. Resources include 
conference rooms, multi-media equipment, and anything else needed for a meeting. 
Resources have their own mailboxes that are maintained by administrators within the 
company. 

 
QUESTION 23: 
 
You have just completed keying a message and you want to place a setting on the message 
that tells the recipient to call. How can this objective be achieved? 
 
A. Click the Follow-up button on the toolbar and select Call from the Flag for follow-up dialog 
box. 
B. Select the Please Call button on the toolbar. 
C. Select the Options button on the toolbar and click the Call flag button in the dialog box. 
D. Select the High Importance button on the toolbar. 
 
Answer: A 
 
Explanation: There is no Please Call Button. The Call flag is not located in the Options 
dialog box, and High Importance has nothing to do with having the message recipient call 
you. To set a message flag, click the Follow-up button no the toolbar and select the desired 
flag from the Flag to field dropdown list. Other examples of message flags are Follow-Up, 
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For Your Information, and Review. You can also key your own flag, such as Call ASAP, 
into the Flag to field. 

 
QUESTION 24: 
 
Pick the correct procedure for assigning a contact to a note. 
 
A. Left click the Note. Select Assign Contact from the shortcut menu. Select the Contacts button 
on the Contacts for Note dialog box, and click Ok. 
B. Right click the Note. Select Assign Contact from the shortcut menu. Select the Contacts 
button on the Contacts for Note dialog box, and click Ok 
C. Open the note. Select the control button in the upper left of the note and select Contacts from 
the menu. Select the Contacts button, and click Ok. 
D. Open the note. Select the control button in the upper right of the note and select Contacts 
from the menu. Select the Contacts button, and click Ok 
 
Answer: C 
 
Explanation: When a contact is assigned to a note, the note can be viewed from the 
Activities tab of the contact window. Right clicking a note cannot be used to assign a 
contact to a note. Left clicking a note does not call up a shortcut menu. 

 
QUESTION 25: 
 
Julies selects the Calendar folder. She wishes to save it as a web page. What format are web 
pages saved in? 
 
A. HTLM 
B. HMTL 
C. HTML 
D. HLTM 
 
Answer: C 
 
Explanation: HTML, which stands for Hypertext Markup Language is the file format used 
so documents can published to the Internet and company Intranets. To save the calendar as 
a web page, select the Calendar folder on the folder list. Click File, Save as Web Page on 
the menu bar. 

 
QUESTION 26: 
 
Select the proper procedures for calling up the View Summary dialog box. Select all that 
apply. 
 
A. Right click in the message pane and select Customize Current View on the shortcut menu. 
B. Right click a folder in the folder list, and select Customize Current View on the shortcut 
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menu. 
C. Select File, Customize Current View on the menu bar. 
D. Select View, Current View, Customize Current View on the menu bar. 
 
Answer: A, D 
 
Explanation: Customizing the view enables you to change how folder contents are viewed. 
Examples include grouping, filtering, and sorting. 

 
QUESTION 27: 
 
Select the proper method to create a meeting? 
 
A. Select the Calendar folder from the folder list. Click the New Meeting button on the toolbar. 
Invite people and it will automatically switch from Meeting to Appointment. 
B. Select the Calendar folder from the folder list. Click the New Appointment button on the 
toolbar. Invite people and it will automatically switch from Appointment to Meeting. 
C. Select the Inbox folder from the folder list. Click the New Appointment button on the toolbar. 
D. Select the Calendar folder from the folder list. Click New Meeting from the Tools menu. 
 
Answer: B 
 
Explanation: Meetings can be created from the New Appointment window. As soon as you 
invite someone to an appointment, it automatically changes to a meeting. Answer A is 
incorrect because the sequence of commands is reversed. 

 
QUESTION 28: 
 
Mia has opened the Sort dialog box while in her Contacts folder. What button can she 
select in the dialog box to clear all sort fields and put the setting back to (none. ? 
 
A. Clear All 
B. Clear 
C. Reset 
D. Erase All 
 
Answer: A 
 
Explanation: Right click a blank area of the contacts pane and select Sort from the menu 
bar to display the Sort dialog box. Select the Clear All button to reset all sort fields to 
(none. . 

 
QUESTION 29: 
 
You have created an appointment. When you activate the shortcut menu by right clicking 
the appointment, what option allows you to set conditions on how the appointment is 
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formatted? 
 
A. Automatic Formatting 
B. Conditional Formatting 
C. Pre-set Formatting 
D. Repeat Formatting 
 
Answer: A 
 
Explanation: To set automatic formatting for an appointment, right click the appointment 
in the Calendar folder and select Automatic Formatting on the shortcut menu. 

 
QUESTION 30: 
 
Pick the proper procedure for assigning an appointment to the Favorites category. 
 
A. Double click the appointment and select Categories on the shortcut menu. Check the 
Favorites category check box, and click Ok. 
B. Left click the appointment and select Categories on the shortcut menu. Check the Favorites 
category check box, and click Ok 
C. Right click the appointment and select Categories on the shortcut menu. Check the Favorites 
category check box, and click Ok 
D. Right click the appointment and select Categories on the shortcut menu. Check the Business 
category check box, and click Ok 
 
Answer: C 
 
Explanation: Assigning categories to appointments make it easy to search for the 
appointment later. Left clicking an appointment does not display a shortcut menu. 

 
QUESTION 31: 
 
Joe has received an e-mail message with an attachment. How can Joe put the file onto his 
hard disk drive? 
 
A. Right click the attachment icon and select Save As on the shortcut menu. Select a folder on 
his hard disk such as My Documents, and click the Save button. 
B. Left click the attachment icon and select Save As on the shortcut menu. Select a folder on his 
hard disk such as My Documents, and click the Save button. 
C. Right click the attachment icon and select Save on the shortcut menu. Select a folder on his 
hard disk such as My Documents, and click the Save button. 
D. Left click the attachment icon and select Save on the shortcut menu. Select a folder on his 
hard disk such as My Documents, and click the Save button. 
 
Answer: A 
 



MOS-OXP 
 

Actualtests.com - The Power of Knowing 
 

Explanation: Answers B and D are incorrect as you don't get a shortcut menu when you 
left click an attachment icon. Answer C is wrong because there is not a Save option on the 
shortcut menu, only Save As. 

 
QUESTION 32: 
 
When receiving a meeting request, which is not an option when responding to the request? 
 
A. Decline 
B. Accept 
C. Tentative 
D. Uncertain 
 
Answer: D 
 
Explanation: When accepting, declining, or tentatively accepting a meeting, you are given 
the option of sending your response to the meeting organizer. 

 
QUESTION 33: 
 
Gayle wants to create a Task and assign two users to the task. How can she accomplish this 
objective? 
 
A. Select the Tasks folder from the folder list. Select the New Task button on the toolbar. Click 
the Assign Task button. Select the To button and double click each name that you want the task 
assigned to. 
B. Select the Tasks folder from the folder list. Select Tools, New Task on the menu bar. Select 
the To button and double click each name that you want the task assigned to. 
C. Select the Inbox folder from the folder list. Select the New Task button on the toolbar. Select 
the To button and double click each name that you want the task assigned to. 
D. Select the Outbox folder from the folder list. Select the New Task button on the toolbar. 
Select the To button and double click each name that you want the task assigned to. 
 
Answer: A 
 
Explanation: Tasks are created and stored in the Tasks folder. Tasks are assignments or 
projects that you assign to yourself or another user. You can also keep track of the 
progress your user is making by opening the task window. 

 
QUESTION 34: 
 
Which style is NOT available when printing a calendar? 
 
A. Tri-fold 
B. Yearly 
C. Monthly 
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D. Weekly 
 
Answer: B 
 
Explanation: To print the calendar in a certain view, select File, Print on the menu bar. 
Select the desired style from the Print Style section. Yearly is not a print style. The other 
missing print style is Daily. 

 
QUESTION 35: 
 
Your Inbox contains ten messages. You want to copy the first five messages into a newly 
created folder called Old Mail. What method can be used to accomplish this task? 
 
A. Select the messages in the Inbox, and drag and drop them into the Old Mail folder. 
B. Select the messages in the Inbox. Select Edit, Copy on the menu bar. Select the Old Mail 
folder. Click inside the message pane. Select Edit, Paste on the menu bar. 
C. Select the messages in the Inbox. Right click the selected messages, and select Copy on the 
shortcut menu. Right click the Old Mail folder and select Paste on the shortcut menu. 
D. Select the messages in the Inbox. Right click the selected messages, and select Cut on the 
shortcut menu. Right click the Old Mail folder and select Paste on the shortcut menu 
 
Answer: B 
 
Explanation: the key here is the word Copy in the question. Answer A would work but the 
messages are relocated and not copied. Answers C and D wouldn't work because Cut/Copy 
and Paste options are not on the shortcut menu. 

 
QUESTION 36: 
 
You are currently viewing the contacts in the Contacts folder. How can you view the 
e-mails, Notes, and Appointments associated with the Myles Cyrlong contact? 
 
A. Right click the contact for Myles Cyrlong. Click the Tracking tab on the shortcut menu. 
Select All items from the Show dropdown list. 
B. Double click the contact for Myles Cyrlong. Click the Tracking tab. Select All items from the 
Show dropdown list. 
C. Double click the contact for Myles Cyrlong. Click the Activities tab. Select All items from the 
Show dropdown list. 
D. Double click the contact for Myles Cyrlong. Click the Actions tab. Select All items from the 
Show dropdown list. 
 
Answer: C 
 
Explanation: By default, when a contact is created, all subsequent activity is tracked from 
the main default folders such as the Inbox, Calendar, and Notes. 
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QUESTION 37: 
 
Alicia has opened her task and is attempting to update the status. What options are not on 
the Status dropdown list? Select all that apply. 
 
A. In Progress 
B. Completed 
C. Assigned to someone else 
D. Finished 
 
Answer: C, D 
 
Explanation: To update the status on a task, open the task and select the desired status on 
the Status dropdown list. In addition to answers A and B, Not Started, Waiting on someone 
else, and Deferred are other choices on the dropdown list. 

 
QUESTION 38: 
 
You have received an e-mail from an external client indicating that her phone number and 
department have changed. You have a contact for this client. What is the best and fastest 
method of updating her contact information? 
 
A. Delete the original contact and create a new one. 
B. Have someone else in your department e-mail you the clients newly created contact 
information. 
C. Select the Contacts folder, double click the clients contact, edit the information, then click the 
Save and Close button.. 
D. Wait for her to e-mail you her contact information as an attachment. 
 
Answer: C 
 
Explanation: Although all four methods could be used to update the clients contact 
information, answer C is, by far, the most efficient. 

 
QUESTION 39: 
 
Nelson has a note with several important phone numbers. How can Nelson save the note as 
a text file? 
 
A. Right click the note icon and select Save As on the shortcut menu. Key a filename and select 
Text Only (*.txt. from the Save as type dropdown list, and click Ok. 
B. Open the note. Select the control button in the upper left hand corner of the note and select 
Save As on the shortcut menu. Key a filename, select Text Only (*.txt. from the Save as type 
dropdown list, and click Ok. 
C. Open the note. Select the control button in the upper right hand corner of the note and select 
Save As on the shortcut menu. Key a filename, select Text Only (*.txt. from the Save as type 
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dropdown list, and click Ok 
D. Open the note. Select the control button in the upper left hand corner of the note and select 
Save on the shortcut menu. Key a filename, select Text Only (*.txt. from the Save as type 
dropdown list, and click Ok 
 
Answer: B 
 
Explanation: Answer A is wrong, as right clicking the note does not give any save options. 
Answer C is wrong because the control button is in the left hand corner not right-hand 
corner. Answer D is wrong because it is the Save As command, not Save. 

 
QUESTION 40: 
 
Joe wants to create a task that repeats every third Thursday of the month. What toolbar 
button can he select in the new Task window to accomplish this objective? 
 
A. Re-occur 
B. Recurrence 
C. Repeating 
D. Replicate 
 
Answer: B 
 
Explanation:  
When the Recurrence button in selected from the toolbar in the new task window, the 
recurrence can be set from the Recurrence Pattern section of the dialog box. An example of 
a recurring task would be a monthly corporate newsletter. 

 
QUESTION 41: 
 
Select all available methods of assigning a category to a contact. Select all that apply. 
 
A. Right click the contact and select Categories on the shortcut menu. 
B. Select the contact, and click Tools, Categories on the menu bar. 
C. Select the contact, and select Edit, Categories on the menu bar. 
D. Select the contact, and perform a Ctrl-C on the keyboard. 
 
Answer: A, C 
 
Explanation: Categories is not a command on the Tools menu nor is the Ctrl-C method a 
keyboard shortcut for assigning categories. 

 
QUESTION 42: 
 
Pick the false statement in reference to contacts. 
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A. Contacts can be created only when the Contacts folder is selected on the folder list. 
B. Contacts are used to store information about frequently contacted people or groups. 
C. When the Contacts folder is selected from the folder list, perform a Ctrl-N on the keyboard to 
create a new contact. 
D. Contacts can be edited after they are created. 
 
Answer: A 
 
Explanation: Although it is most common to create a contact from the Contacts folder. You 
can create a contact no matter what folder you are in if you select File, New, Contact on the 
menu bar. 

 
QUESTION 43: 
 
You are creating a new appointment. How can you attach the Myles Cyrlong contact to the 
appointment so it can be tracked? 
 
A. Click the Contacts button at the top of the Appointments window. 
B. Click the Contacts button at the bottom of the Appointments window. 
C. Click the Contacts button on the toolbar. 
D. Click Contacts, Add on the menu bar. 
 
Answer: B 
 
Explanation: Contacts can be attached to appointments and tasks so they can be tracked 
from the Contacts folder. 

 
QUESTION 44: 
 
David has decided to sort the contacts in his Contacts folder. What is the maximum 
number of fields will he be able to sort by? 
 
A. 3 
B. 4 
C. 5 
D. 2 
 
Answer: B 
 
Explanation: The easiest way to sort a contact list is to select the Contacts folder from the 
folder list. Right click a blank area of the contact pane, and select Sort from the shortcut 
menu. The Sort dialog box contains four sort field dropdown lists. 

 
QUESTION 45: 
 
Besides the File menu, what other menu bar item can be used to create a new mail 
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message? 
 
A. Tools 
B. View 
C. New 
D. Actions 
 
Answer: D 
 
Explanation:  
Selecting Actions, New Mail Message on the menu bar is a less common method of 
creating a new mail message. The most common method is to either click the New Message 
button on the toolbar or by double clicking a blank area of the message pane. 

 
QUESTION 46: 
 
Pick all TRUE statements in reference to notes. Select all that apply. 
 
A. Categories can be assigned to notes. 
B. The note color cannot be changed. 
C. Note text can be saved as a text file. 
D. The font of note text cannot be changed. 
 
Answer: A, C 
 
Explanation: Assign a category to a note by right clicking the note and selecting Categories 
on the shortcut menu. Save note text as a text file by selecting the note control button and 
selecting Save As on the menu bar. Change note font by selecting Tools, Options on the 
menu bar, and selecting the Notes Options button from the Preferences section of the 
Options dialog box. Select the font button on the Notes Options dialog box, and click Ok. 

 
QUESTION 47: 
 
Pick the FALSE statement in reference to creating appointments. 
 
A. Once an appointment is created, it can be edited. 
B. Appointments can be created from the Calendar folder. 
C. Appointments change to events as soon as someone from the address book is invited. 
D. An appointment that takes place every Tuesday is called a recurring appointment. 
 
Answer: C 
 
Explanation: Answer C is false because when an appointment is created, and someone is 
invited, it changes to a Meeting not an Event. An appointment changes to an event if the 
All day event checkbox is checked when in the Appointment window 
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QUESTION 48: 
 
You have created a new mail message that needs the recipient's immediate attention. You 
also want definite confirmation that the message was delivered and read by the recipient. 
What message options can you apply to the message so the objectives are satisfied? 
 
A. Set the importance level to High and request a read receipt 
B. Set the importance level to High and request a delivery and read receipt. 
C. Set the importance level to High and request a delivery receipt 
D. Set the importance level to Normal and request a delivery and read receipt 
E. Set the sensitivity level to Private and request a delivery and read receipt 
 
Answer: B 
 
Explanation: Answer A is missing Delivery confirmation. Answer C is missing a Read 
receipt. Answer D uses the Normal priority level, which doesn't satisfy the urgency 
objective. Answer E uses the Low priority level, which doesn't satisfy the urgency 
objective. Answer B satisfies all objectives: High importance, Delivery Receipt, and Read 
Receipt. Answer E is incorrect as sensitivity was not an objective in the question. 

 
QUESTION 49: 
 
Jerry has created a new message and his default signature named Business displays in the 
new message. He wants to use the signature named Personal for this one message. What is 
the most efficient way he can replace the Business signature with the Personal signature for 
this one message? 
 
A. He should highlight the existing signature text in the message window and hit the DEL 
(delete. key. He should then go to the Create New Signature dialog box, delete the Business 
signature, and create a new signature named Personal. 
B. He should highlight the existing signature text in the message window and hit the DEL 
(delete. key. He should then select the Personal signature choice from the Signature button on 
the Formatting toolbar. 
C. He should highlight the existing signature text in the message window and hit the DEL 
(delete. key. He should then select the Personal signature choice from the Signature button on 
the Standard toolbar. 
D. He should highlight the existing signature text in the message window and hit the DEL 
(delete. key. He should then select the Personal signature choice from the Signature button on 
the Advanced toolbar. 
 
Answer: C 
 
Explanation:  
Answer A would work but is very inefficient. In answer D, there is no Advanced toolbar in 
a new message window. The Formatting toolbar is used to format data not insert 
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signatures. Selecting the Signature button on the Standard toolbar gives you a dropdown 
list of available signatures. 

 
QUESTION 50: 
 
You want to assign a newly created task to three of your existing contacts. How can this be 
done from the Task window? 
 
A. Select the Assign Task button on the toolbar. Select Contacts from the Show Names from the 
dropdown list. Single click each name that will be assigned the task. 
B. Select the Assign Task button on the toolbar. Select Contacts from the Show Names from the 
dropdown list. Double click each name that will be assigned the task. 
C. Select the Task Distribution button on the toolbar. Select Contacts from the Show Names 
from the dropdown list. Double click each name that will be assigned the task. 
D. Select the Task Assignment button on the toolbar. Select Contacts from the Show Names 
from the dropdown list. Double click each name that will be assigned the task. 
 
Answer: B 
 
Explanation: Answer A is incorrect as single clicking a name does not move to the To 
window. Answers C and D are incorrect as there is no Task Distribution or Task 
Assignment buttons on the toolbar. 

 
QUESTION 51: 
 
Select all methods that can be used to create a contact. Select all that apply. 
 
A. Select the Contacts folder in the folder list. Click the New Contact button on the toolbar. Key 
in the contact information, and click the Save and Close button on the toolbar. 
B. Select Tools, New Contact on the menu bar. Key in the contact information, and click the 
Save and Close button on the toolbar. 
C. Select the Contacts folder in the folder list. Perform Ctrl-N on the keyboard. Key in the 
contact information, and click the Save and Close button on the toolbar. 
D. Select the Contacts folder in the folder list. Right click anywhere in the contacts window, and 
select New Contact on the shortcut menu. Key in the contact information, and click the Save and 
Close button on the toolbar. 
 
Answer: A, C, D 
 
Explanation: All are valid methods of creating a contact except answer B. The Tools menu 
does not have any contact options. 

 
QUESTION 52: 
 
You currently have over 100 contacts in your Contacts folder. Seventeen of these contacts 
have been added to the Favorites category. How can you run a search so only those 
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contacts display in the Contacts folder? 
 
A. Select the Contacts folder from the folder list. Select the Search button on the toolbar. Key 
Favorites into the Look for field. Select the Find Now button. 
B. Select the Contacts folder from the folder list. Select the Find button on the toolbar. Key 
Favorites into the Look for field. Select the Search Now button 
C. Select the Contacts folder from the folder list. Select the Look for button on the toolbar. Key 
Favorites into the Look for field. Select the Find Now button 
D. Select the Contacts folder from the folder list. Select the Find button on the toolbar. Key 
Favorites into the Look for field. Select the Find Now button 
 
Answer: D 
 
Explanation: Categories are used to store related Outlook items so they are easy to search 
for later. To add a contact to a category, right click the contact and select Categories on the 
shortcut menu. Check the desired category that will store the contact, and click OK. 

 
QUESTION 53: 
 
Pick the TRUE statements about scheduling resources for a meeting. Select all that apply. 
 
A. Resources are always required attendees. 
B. Resources consist of conference rooms, projectors, and any other meeting support materials 
and equipment. 
C. Resources have their own mailboxes that are maintained by administrators. 
D. A conference room which is specified as a resource will automatically accept a meeting 
request if the room is available and the person requesting it is authorized to do so. 
 
Answer: B, C, D 
 
Explanation: Resources are primarily non-human elements needed for a meeting. Resource 
examples include conference rooms, media projectors, and other support materials. 
Resources have their own mailboxes which can accept or decline meeting requests. These 
mail boxes are maintained by an administrator within the company. 

 
QUESTION 54: 
 
Thomas wants to print a four-page e-mail message, and have his name appear at the top 
right corner of each page. How can he accomplish this objective? 
 
A. Select File, Print on the menu bar. Select the Page Setup button on the Print dialog box. Select 
the Header/Footer tab. Click the left box of the Header section, key his name, and click Ok. 
B. Select File, Print on the menu bar. Select the Paper Setup button on the Print dialog box. 
Select the Header/Footer tab. Click the left box of the Header section, key his name, and click 
Ok 
C. Select File, Print on the menu bar. Select the Page Setup button on the Print dialog box. Select 
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the Header/Footer tab. Click the left box of the Footer section, key his name, and click Ok 
D. Select File, Print on the menu bar. Select the Page Setup button on the Print dialog box. Select 
the Header/Footer tab. Click the right box of the Footer section, key his name, and click Ok 
 
Answer: D 
 
Explanation: Answers C and D are wrong as the questions states top right and answers C 
and D specify footers. Answer B is incorrect because there is no Paper Setup dialog box. 

 
QUESTION 55: 
 
You have updated several contacts in your contacts folder but whenever you return to the 
contact, the changes are not there. What is the most likely cause of this situation? 
 
A. The contacts were created in the wrong folder. 
B. You did not save the changes when you exited the contact after editing. 
C. You should have deleted the contact and started fresh. 
D. You are not allowed to save changes. 
 
Answer: B 
 
Explanation: Whenever you make changes to a contact, you should click the Save and 
Close button on the toolbar. If the contact is not saved, the changes will not take effect. 

 
QUESTION 56: 
 
Pick the FALSE statements about formatting an appointment. Select all that apply. 
 
A. Automatic formatting can be set according to user specified rules. 
B. Appointments cannot be formatted according to user specified rules. 
C. Automatic formatting is applied by right clicking the appointment, and selecting Automatic 
Formatting on the shortcut menu. 
D. Automatic formatting is applied by left clicking the appointment. 
 
Answer: B, D 
 
Explanation: To set automatic formatting for a message, right click the appointment and 
select Automatic Formatting on the shortcut menu. Click the Condition button on the 
Automatic Formatting dialog box. 

 
QUESTION 57: 
 
Marcia has set the For Your Information follow-up flag on her newly created message. 
How will the flag look when the recipient receives and opens the message? 
 
A. It will be within the message body 
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B. It will appear at the bottom of the message window on the status bar. 
C. It will show as a yellow bar going across the top of the message window. 
D. It will display as red bar going across the top of the message window 
 
Answer: C 
 
Explanation: Flags are used as reminders for the sender or receiver. They appear as a 
yellow bar the top of the message and are set in a new message by clicking the Follow?up 
button on the toolbar. 

 
QUESTION 58: 
 
Bill is performing an advanced search for messages in his Inbox folder but the search is 
taking longer than expected. What button can Bill select to halt the search? 
 
A. Clear 
B. Quit 
C. Exit 
D. Stop 
 
Answer: D 
 
Explanation: Selecting the Stop button causes Outlook to stop searching. 

 
QUESTION 59: 
 
Toni has six new e-mail messages in the Inbox folder. Two of the messages have 
attachments. How does Toni know this without opening the messages? 
 
A. Staple symbols next to the messages. 
B. Paper clip symbols next to the messages. 
C. The word "attachment" is part of the subject line. 
D. The filename appears in the subject line 
 
Answer: B 
 
Explanation: Small paper clip symbols appear next to messages with attached files when 
viewing the messages in the Inbox. 

 
QUESTION 60: 
 
Pick the FALSE statements in reference to moving e-mail messages? Select all that apply. 
 
A. Messages can be moved into a folder by dragging and dropping them into the target folder. 
B. When messages are moved into another folder, the original messages remain in the original 
folder. 



MOS-OXP 
 

Actualtests.com - The Power of Knowing 
 

C. Only one message can be moved at a time. 
D. When a folder that contains messages is moved to the Deleted Items folder, the messages 
within the folder are deleted as well. 
 
Answer: B, C 
 
Explanation: Multiple messages can be moved at the same time. Dragging and dropping is 
the most common method of moving messages. When messages are moved, they are 
removed from the original folder. 

 
QUESTION 61: 
 
David has decided to sort the contacts in his Contacts folder. What is the maximum 
number of fields will he be able to sort by? 
 
A. 3 
B. 4 
C. 5 
D. 2 
 
Answer: B 
 
Explanation: The easiest way to sort a contact list is to select the Contacts folder from the 
folder list. Right click a blank area of the contact pane, and select Sort from the shortcut 
menu. The Sort dialog box contains four sort field dropdown lists. 

 
QUESTION 62: 
 
What is the default file format for all newly created e-mail messages? 
 
A. Rich Text Format 
B. PDF 
C. Text 
D. HTML 
 
Answer: D 
 
Explanation: The default file format for new messages is HTML. This format supports 
most mail server formats. Attributes such as bold, underline, italics, font colors, and bullets 
and numbering are formatted by this format. 

 
QUESTION 63: 
 
How can John create a new category called Office so he can assign it to his already existing 
appointment? 
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A. Right click the appointment and select Categories on the shortcut menu. Key Office into the 
window and click the Add button. Check the box for the newly created Office category, and 
click Ok. 
B. Left click the appointment and select Categories on the shortcut menu. Key Office into the 
window and click the Add to list button. Check the box for the newly created Office category, 
and click Ok 
C. Double click the appointment and select Categories on the shortcut menu. Key Office into the 
window and click the Add to list button. Check the box for the newly created Office category, 
and click Ok 
D. Right click the appointment and select New Categories on the shortcut menu. Key Office into 
the window and click the Add to list button. Check the box for the newly created Office 
category, and click Ok 
 
Answer: A 
 
Explanation: Categories can be assigned to appointments so they can be easily searched for 
later. The Categories dialog box can also be accessed from the Edit menu. 

 
QUESTION 64: 
 
Three days ago you created a meeting and invited 15 people. Everyone has accepted your 
meeting invitation. This morning, you realize you had a previous engagement with an out 
of state sales representative on the same day as the meeting. What is the best method of 
canceling the meeting and letting the 15 attendees know that the meeting has been 
cancelled? 
 
A. Delete the meeting from the calendar, and call each attendee to inform him/her that the 
meeting has been cancelled. 
B. Leave the meeting on the calendar and when the people show up on the meeting date, tell 
them that the meeting has been cancelled. 
C. Delete the meeting from the calendar. When the dialog box displays, select the Send 
cancellation and delete meeting option button, and select Ok. 
D. Delete the meeting from the calendar. When the dialog box displays, select the Delete without 
sending a cancellation option button. 
 
Answer: C 
 
Explanation: Answer A is effective but grossly inefficient. Answers B and D would have 
many people upset with you. Answer C is the best method to use when canceling a meeting. 
Answer C is the most common method of deleting a meeting and sending an update e mail 
to all meeting attendees. 

 
QUESTION 65: 
 
Jerry is creating a new meeting request and has invited six people to the meeting. What tab 
can he select in the Meeting window to see if the attendees will be available and will most 
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likely accept the meeting request? 
 
A. Attendee Availability 
B. Attendee Timetable 
C. Attendee Access 
D. Attendee Contact 
 
Answer: A 
 
Explanation: Clicking the Attendee Availability tab at the top of the Meeting window 
allows you to see if your meeting attendees will be available for the meeting. This is a 
positive step in determining if your attendees will accept or decline your meeting request. 

 
QUESTION 66: 
 
Josh selects his Tasks folder and notices that several tasks contain a check mark. What 
does this check mark indicate? 
 
A. New task 
B. Task not yet started 
C. Task halfway complete 
D. Task completed 
 
Answer: D 
 
Explanation: When someone who has been assigned a task checks the task checkbox, the 
task is marked as completed and a message is sent to the person who delegated the task 
informing them that the task has been completed. 

 
QUESTION 67: 
 
Tom wants to only see messages that were sent yesterday. How can he accomplish this 
task? 
 
A. Click View, Current View, Customize Current View on the menu bar. Select the Filter button 
on the view Summary Dialog box. Select Received and Yesterday from the Date: dropdown lists. 
Click Ok two times. 
B. Click File, Current View, Customize Current View on the menu bar. Select the Filter button 
on the View Summary Dialog box. Select Received and Yesterday from the Time: dropdown 
lists. Click Ok two times 
C. Click View, Current View, Customize Current View on the menu bar. Select the Filter button 
on the View Summary Dialog box. Select Received and Yesterday from the Time: dropdown 
lists. Click Ok two times 
D. Click Tools, Current View, Customize Current View on the menu bar. Select the Filter button 
on the View Summary Dialog box. Select Received and Yesterday from the Time: dropdown 
lists. Click Ok two times 
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Answer: C 
 
Explanation: Customizing views allows you to see only the messages you want to see. 
Messages can be sorted, filtered, and grouped. 

 
QUESTION 68: 
 
Pick the FALSE statements in reference to assigning categories to messages. Select all that 
apply. 
 
A. Assign a category when the message is open by selecting Edit, Categories on the menu bar. 
B. Right click the message in the Inbox and select Categories on the shortcut menu. 
C. Categories cannot be assigned to messages 
D. Assign a category when the message is selected in the Inbox, and click Edit, Categories on the 
menu bar. 
 
Answer: A, C 
 
Explanation: The key to this type of question is to isolate the TRUE answers. In this case, B 
and D are true so A and C are the answers. The Edit menu does not have a Categories 
command when the message is open. 

 
QUESTION 69: 
 
Select the true statements in reference to assigning tasks to contacts. Select all that apply. 
 
A. Tasks cannot be assigned to contacts 
B. Only one contact can be assigned to a task. 
C. Tasks can have multiple contacts assigned to it. 
D. Contacts can be removed from a task. 
 
Answer: C, D 
 
Explanation: To assign a task to multiple contacts, click the Assign Task button on the 
toolbar. Click the To button. Select Contacts from the Show Names from the dropdown list 
and double click each contact that will be assigned the task. Click Ok. 

 
QUESTION 70: 
 
You have just received six messages which are now in your Inbox folder. Three of these 
messages have the High Importance message setting. What symbol is used to indicate a 
message has been set with High Importance? 
 
A. & 
B. # 
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C. ! 
D. @ 
 
Answer: C 
 
Explanation: A red exclamation mark next to a message indicates that it has been sent with 
High Importance and the message should be read immediately. 

 
QUESTION 71: 
 
You currently have a message open. What is the correct menu bar sequence to save the 
message as a text only file to the disk in drive A:? 
 
A. Select File, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in drop 
down list at the top of the Save As dialog box. Select Text Only (*.txt. from the Save as type 
dropdown list. Click the Save button. 
B. Select Tools, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in 
drop down list at the top of the Save As dialog box. Select Text Only (*.txt. from the Save as 
type dropdown list. Click the Save button. 
C. Select File, Save As on the menu bar. Select the 3 ? Floppy (A:. option from the Look in drop 
down list at the top of the Save As dialog box. Select Rich Text Format (*.rtf. from the Save as 
type dropdown list. Click the Save button. 
D. Select File, Save As Text File on the menu bar. Select Text Only (*.txt. from the Save as type 
dropdown list. Click the Save button. 
 
Answer: A 
 
Explanation: Answer B is incorrect as the Save As command is not on the Tools menu. 
Answer C saves the file as a Rich Text Format file. Answer D is incorrect because there is 
no Save As Text File command on the menu bar. By default, the default folder would be 
My Documents which is on drive C. 

 
QUESTION 72: 
 
What is the keyboard shortcut to insert an Office Document into your message? 
 
A. Ctrl-Shift-T 
B. Ctrl-Shift-P 
C. Ctrl-Shift-H 
D. Ctrl-Shift-O 
 
Answer: C 
 
Explanation: To see keyboard shortcuts, click File, New on the menu bar. Keyboard 
shortcuts are listed to the right of the command. Performing a Ctrl-Shift-H on the 
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keyboard calls up the New Office Document dialog box where you can select to insert a 
Word, Excel, Excel Chart, or PowerPoint document. 

 
QUESTION 73: 
 
Gayle has a folder named Important Mail. The folder contains over 100 messages. She 
wants to be able to empty the folder but she doesn't want to lose the important messages 
within the folder. How can she archive the folder? 
 
A. Select the Important Mail folder from the folder list. Select Tools, Backup on the menu bar. 
Key the filename and path into the Archive File field, and click Ok. 
B. Select the Important Mail folder from the folder list. Select File, Archive on the menu bar. 
Key the filename and path into the Archive File field, and click Ok 
C. Select the Important Mail folder from the folder list. Select Tools, Archive on the menu bar. 
Key the filename and path into the Archive File field, and click Ok 
D. Select the Important Mail folder from the folder list. Select File, Backup on the menu bar. 
Key the filename and path into the Archive File field, and click Ok 
 
Answer: B 
 
Explanation: Archiving a folder takes all of the messages in the selected folder and places 
them into a user specified file with the pst filename extension. 

 
QUESTION 74: 
 
Pick the two best methods of changing a meeting time. Select two answers? 
 
A. Double click the meeting in the calendar; change the start and time then click the save 
and Close button. Click Yes on the dialog box so the update is sent to all meeting attendees. 
Click the Send Update button on the toolbar. 
B. With the Calendar folder selected, click and drag the meeting to a different time. Click Yes on 
the dialog box so the update is sent to all meeting attendees. Send the update to the attendees. 
C. Delete the meeting then re-create it re-inviting all attendees. 
D. Don't change the meeting time, just call all of the attendees and tell them verbally of the new 
meeting time. 
 
Answer: A, B 
 
Explanation: Although all answers could be used, the question stated select the two BEST 
methods. Answers A and B are the most common methods of updating a meeting time. 

 
QUESTION 75: 
 
Jane wants to update her task so that it is marked as urgent. How can she accomplish this 
objective? 
 



MOS-OXP 
 

Actualtests.com - The Power of Knowing 
 

A. Set the Priority level to High 
B. Set the Priority level to Low 
C. Set the Priority level to Urgent 
D. Set the Priority level to ASAP 
 
Answer: A 
 
Explanation: To set the priority level of a task, open the task and select the desired priority 
level from the Priority dropdown list. Normal, Low, and High are the three priority levels 
that can be set for a task. 

 
QUESTION 76: 
 
Lyle has just accepted a task from his boss. When he clicks the Accept button to accept the 
task, what two options appear on the Accepting Task dialog box? Select two answers. 
 
A. Edit the Response before Sending 
B. Send Response Now 
C. Add and Send Response Now 
D. Apply and Send Response Now 
 
Answer: A, B 
 
Explanation: To accept a task, open the task from the Inbox folder by double clicking it. 
Click the Accept button at the top of the task window. When accepting a task, you have the 
option of sending the acceptance response to the person assigning the task, or you can edit 
the task before sending the response. 

 
QUESTION 77: 
 
Lyle has attached the Henry Jones contact to a note. How can Lyle view the note when he 
opens Henry's contact? 
 
A. Open the contact. Select the Details tab, and double click the note icon. 
B. Open the contact. Select the General tab, and double click the note icon. 
C. Open the contact. Select the Assignments tab, and double click the note icon. 
D. Open the contact. Select the Activities tab, and double click the note icon. 
 
Answer: B 
 
Explanation: When viewing the activities for a contact, you can see all information 
pertaining to the contact including notes, tasks, appointments, and meetings. 

 
QUESTION 78: 
 
You currently have over 100 messages in your Inbox folder. What procedure can you use 
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to search for those messages that contain the word Meeting in the subject line? 
 
A. Click the Search button on the toolbar. Click the Advanced Find button. Key Meeting in the 
Search for the words field and select Messages from the Look for dropdown list. Click the Find 
Now button. 
B. Click the Find Now button on the toolbar. Click the Advanced Find button. Key Meeting in 
the Search for the words field and select Messages from the Look for dropdown list. Click the 
Find button 
C. Click the Search Now button on the toolbar. Click the Advanced Find button. Key Meeting in 
the Search for the words field and select Messages from the Look for dropdown list. Click the 
Search Now button 
D. Click the Find button on the toolbar. Click the Advanced Find button. Key Meeting in the 
Search for the words field and select Messages from the Look for dropdown list. Click the Find 
Now button. 
 
Answer: D 
 
Explanation: Other search criteria that can be searched from the Advanced Find dialog 
box are whom the message is from, whom the message was sent to, and the time the 
message was created, among others. 

 
QUESTION 79: 
 
You have assigned a task to Carol and she has accepted it. Later, you tell Carol to go ahead 
and delete the task from her Task folder. When Carol deletes the task, she is presented 
with the Delete Incomplete Task dialog box. What three options are on the dialog box? 
Select three answers. 
 
A. Decline and Delete 
B. Accept and Delete 
C. Mark Complete and Delete 
D. Delete 
 
Answer: A, C, D 
 
Explanation: When you attempt to delete a task that has been assigned to you, you are 
presented with the Delete Incomplete Task dialog box displaying the choices in answers A, 
C, and D. In the question scenario, Carol would most likely select the Delete option from 
the dialog box. 

 
QUESTION 80: 
 
Pick the FALSE statements in reference to changing a meeting time. Select all that apply. 
 
A. Meeting times cannot be updated 
B. When a meeting has been changed updates are not sent to the attendees 
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C. Meeting times can be changed by clicking and dragging the meeting when in viewing the 
calendar. 
D. When meeting times conflict with each other, you are not notified. 
 
Answer: A, B, D 
 
Explanation: When you schedule a meeting time that conflicts with another time on the 
calendar, you are prompted with a message indicating that there is a conflict. This message 
appears as a long yellow bar across the top of the window. When you change the meeting 
date and/or time, you are given the option to send updated meeting requests to the 
attendees 

 
QUESTION 81: 
 
You are attempting to assign a category to three of your most important contacts. How can 
you select all three contacts and assign the Favorites category to the clients in one 
operation? 
 
A. Hold down Alt while selecting each contact. 
B. Hold down Shift while selecting each contact 
C. Hold down Spacebar while selecting each contact 
D. Hold down Ctrl while selecting each contact 
 
Answer: D 
 
Explanation: To assign the Favorites category to three contacts, select the first contact then 
click each of the other two contacts. With all three contacts selected, click Edit, Categories 
on the menu bar. Check the Favorites check box, and click Ok. 

 
QUESTION 82: 
 
Joe is attempting to print his calendar using the Daily style. He currently has the Calendar 
folder selected and the Print dialog box displayed. How can he see how the page will look 
when it is actually printed without wasting paper? 
 
A. Click the Page View button on the dialog box. 
B. Click the Preview button on the dialog box. 
C. Click the Print View button on the dialog box. 
D. Click the Paper View button on the dialog box. 
 
Answer: B 
 
Explanation: Selecting the Preview button on the Print dialog box opens a window and 
displays the page as it will appear when printing. 
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QUESTION 83: 
 
Select two examples of meeting resources. Select two answers. 
 
A. Conference room 
B. Tom from the media center. 
C. Overhead projector 
D. The person who scheduled the meeting 
 
Answer: A, C 
 
Explanation: Resources are non-human elements of a meeting. Resources have their own 
mail boxes and can automatically accept and decline meeting requests. The person who 
created the meeting is the meeting organizer. Other resources could be televisions, 
conference centers, and speakers. 


